
      
Experiment 16: Grip Strength and EMG Activity in 
the Forearm

Background A motor unit is composed of a motorneuron and all the muscle 
fibers that are innervated by that motorneuron. In a persistent muscle 
contraction, like a clench, multiple motor units are firing repetitively 
throughout the contraction of the muscle. The strength of a muscle 
contraction is related to the number of motor units in the muscle that 
are activated during the same time period. The electromyogram 
(EMG) recorded during the muscle contraction is seen as a burst of 
spike-like signals, and the duration of the burst is about equal to the 
duration of the muscle contraction.

The strength of a striated muscle contraction is directly propor-
tional to the amount of electrical activity in the muscle. However, it is 
difficult to quantify the amount of electrical activity in a muscle unless 
the raw EMG data is mathematically transformed. One of the most 
common transformations used is the integration of the absolute 
values of the amplitudes of the EMG spikes. Through this transfor-
mation, it has been found that the area under the graph of the 
absolute integral of the EMG is linearly proportional to the strength of 
the muscle contraction.

In this experiment, students will use a hand dynamometer to 
measure a subject’s grip strength as the EMG activity of the forearm 
muscles used to generate the subject’s grip are recorded. The EMG 
activity will be related to the grip strength by plotting the maximum 
grip strength as a function the area under the absolute integral of the 
EMG activity during the muscle contraction. Data recordings will be 
made from the subject’s dominant and non-dominant forearms, and 
the relative strength and electrical activity of each forearm will be 
compared to its diameter. Recordings of prolonged grip strength and 
forearm EMG activity will also be made to determine the rate of 
fatigue in the dominant and non-dominant forearms.

Equipment 
Required

PC Computer

iWorx unit, and USB or serial cable

AAMI cable and five EMG leads

Hand Dynamometer

Alcohol swabs

5 or 6 textbooks

Bathroom scale
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Equipment 
Setup

1 Connect the iWorx unit to the computer (described in Chapter 1).

2 Attach the AAMI connector on one end of the cable to the isolated 
Channel 1 and 2 inputs on the iWorx unit.

3 Connect the hand dynamometer to the input of Channel 3 on the iWorx 
unit.

4 The subject should remove all jewelry from their wrists. For the first 
exercises in this lab, record EMG’s and clench forces from the subject’s 
dominant arm, the arm used most often. 

5 Use an alcohol swab to clean and scrub three regions on the subject’s 
dominant forearm where the electrodes will be placed (Figure 3-1 on page 
2). One area is near the wrist, the second is in the middle of the forearm, 
and the third area is about 2 inches from the elbow. Let the areas dry 
before attaching the electrodes.

6 Remove the plastic disk from a disposable electrode and apply it to one of 
the scrubbed areas. Repeat for the other two areas. 

7 Attach three color-coded electrode cables to the ground and Channel 1 
inputs on the lead pedestal and snap the other ends onto the disposable 
electrodes, so that:

• the red “+1” lead is attached to the electrode near the elbow

• the black “-1” lead is attached to the electrode in the middle of the forearm.

• the green “C” lead (the ground) is attached to the electrode on the wrist.

 Figure 3-1: The equipment used to monitor EMGs from a volunteer.
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Start the 
Software

1 Click the Windows Start menu, move the cursor to Programs and then to 
the iWorx folder and select LabScribe; or click on the LabScribe icon on 
the Desktop

2 When the program opens, select Load Group from the Settings menu.   

3 When the dialog box appears, select AddedLabs.iws. Click Load.

4 Click on the Settings menu again and select the EMGMuscleStrength 
settings file.

5 After a short time, LabScribe will appear on the computer screen as 
configured by the EMGMuscleStrength settings.

Calibrating the 
Hand 
Dynamometer

1 Gather a stack of 5 or 6 textbooks.

2 Lay the hand dynamometer down on the bench top.  Click the Start button 
on the LabScribe Main window and record for 10 seconds.

3 Continue to record as you place the stack of text books on the bulb of the 
hand dynamometer.  Once the recording is stabile for 10 seconds, click 
the Stop button.

4 Weight the stack of books on a scale.

5 Use the Display Time icons to adjust the time displayed on the Main 
window. On one screen width, display the recording from the time before 
and to the time after the stack of books was placed on the bulb.

6 Click the 2-cursor icon on the toolbar.  Place a cursor on the section of 
the recording before the stack of textbooks was placed on the bulb.  Place 
the other cursor on the section after the textbooks were placed on the 
bulb.

7 Right-click on the data display area of the Force (CH3) channel.  Select 
Units from the right-click menu.  Type zero (0) in the box next to the 
voltage value of the first cursor; type the weight of the stack of textbooks 
(in kg)  in the box next to the voltage value of the second cursor.  Type the 
unit ” kg”  in the Name box.  Click the OK  button.

Exercise 1: 
EMG Intensity 
and Force

Aim: To determine the relationship between the intensity of EMG 
activity and the force of a muscle contraction.

Procedure 1 The subject should sit quietly with his or her dominant forearm resting on 
the table top.  Explain the procedure to the subject.  The subject will 
clench his or her fist around the hand dynamometer four times, each 
clench is two seconds long followed by two seconds of relaxation.  Each 
clench should be stronger than the previous one.
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2 Click the Start button to begin recording. Type “Increasing Clenches” in 
the comment line to the right of the Marks button. Press the Enter key on 
the keyboard. The subject should clench the hand dynamometer with 
progressively stronger force as directed by the procedure outlined in the 
previous step.  After the last two second relaxation of the last clench 
cycle, click the Stop button. 

3 Click the AutoScale buttons for the EMG (CH 1), EMG Integral (CH 2), 
and Force (CH3) channels. The recording should be similar to Figure 3-2 
on page 4.

4 Select Save As in the File menu, type a name for the file. Choose a desti-
nation on the computer in which to save the file(e.g. the iWorx or class 
folder). Click the Save button to save the file (as an *.iwd file).

 Figure 3-2: The EMG (upper), EMG absolute integral (middle), and clenching force 
(lower) for four progressively stronger clenches displayed in the Main window. 

Data Analysis 1 Adjust the time displayed on the Main window to display the subject’s four 
clenches on the screen (Figure 3-2 on page 4). Use the Display Time  
icons on the LabScribe toolbar (Figure 3-3 on page 5), or the Display 
Time  box on the Channels page of the Preferences dialogue window on 
the Edit menu, to set the proper screen width. exceed the total number of 
points in the data block. Click OK. 

2 Click the 2-cursor icon on the toolbar.  Place the two cursors on either 
side of the four clench cycles displayed in the Main window.  Click the 
Analysis icon on the toolbar to send the data to the Analysis window.
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 Figure 3-3: The LabScribe toolbar.

3 Select EMG and EMG Integral from the Display Channels menu, EMG 
Integral on the Value from Ch pull-down menu, and Title and Area from 
the Table Functions menu. Place the two cursors on the Analysis 
window on either edge of the first raw EMG cluster (Figure 3-4 on page 5). 
Record the value for Area in the Journal. Do not move the cursors from 
their positions around the first EMG cluster. 

 Figure 3-4: The EMG and EMG absolute integral displayed in the Analysis window.  
The cursors are placed on the margins of the second cluster of EMG signals.  The area of 
the EMG Integral is taken from the region between the cursors on the second channel.

4 Data can be entered into the Journal by either typing the titles and values 
directly or by using the right-click menu. Place the cursors to take 
measurements; then, select Add Title to Journal or Add Data to Journal 
from the right click menu to add the measurements to the Journal.

5 Control-click on Force in the Display Channels menu to add this channel 
to the display on the Analysis window. Select Force on the Value from 
Ch pull-down menu, and Title and Mean from the Table Functions menu. 
Place the two cursors on the Analysis window at either end of the 
maximum force plateau on the Force channel (CH3) as indicated in 
Figure 3-5 on page 6. Record the value for the Mean in the Journal.
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 Figure 3-5: Recording of the EMG, EMG absolute integral, and clench force displayed in 
the Analysis window. The cursors are placed on the Force channel so that the average 
amplitude on the plateau can be measured.

6 Move the cursors on the Analysis window to either end of the force 
plateau for the second fist clench and repeat Steps 3, 4, and 5

7 Repeat Steps 3, 4, 5, and 6 for the two other fist clenches in the set.

Questions 1 Plot the force of the muscle clenches as a function of the areas under the 
EMG absolute integral for each muscle clench. 

2 Is there a linear relationship between the area under EMG absolute 
integral for each clench and the force of the clench?

3 Do muscle fibers have a refractory period like nerve fibers? 

4 Does the amplitude of the EMG signal and the force of contraction 
increase because a finite number of fibers are firing more often, or 
because more fibers are recruited to fire as the intensity of signals in the 
motorneurons increases, or a combination of these two?
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Exercise 2: 
EMG Intensity 
and Fatigue in 
Dominant Arm

Aim: To observe the relationship between the length and strength of 
a muscle contraction and EMG activity in the dominant forearm.

Procedure 1 The subject should sit quietly with his or her dominant forearm on the 
table top.  Explain the procedure to the subject.  The subject will clench 
the hand dynamometer as tight and as long as possible in an attempt to 
fatigue the muscles of the forearm.  When the subject’s clench force falls 
below 50% of the maximum clench force, the recording can be halted.

2 Click the Start button on the LabScribe Main window to begin recording. 
record a baseline for a few seconds, then the subject should clench the 
hand dynamometer with maximum force. Click the AutoScale buttons on 
all three recording channels.  Continue to record the fatigue of the 
subject’s forearm until the force of the muscle contraction drops below 
50% of the maximum; at that time, click the Stop button. 

3 Use a tailor’s tape measure to determine the circumference of the widest 
part of the subject’s dominant forearm. Record your findings in the 
Journal.

4 Select Save in the File menu. 

Data Analysis 1 Adjust the screen time of the Main window to display the complete record 
of this experiment on the same screen.

2 Click the 2-cursor icon on the LabScribe toolbar (Figure 3-3 on page 5).  
Place one cursor on the relaxation period that precedes the fatigue 
exercise.  Place the second cursor to the right of the point when the 
subject released the bulb of the hand dynamometer. Click the Analysis 
icon on the toolbar to send the data to the Analysis window (Figure 3-6 
on page 8). 

3 Select Force from the Display Channels  menu, and Title, V2-V1, and 
T2-T1 from the Table Functions menu.  Place one cursor on the relax-
ation period before the maximum contraction and the second cursor on 
the peak of the muscle contraction.  The difference in amplitude (V2-V1) is 
the maximum clench force of the subject, which should be recorded in the 
Journal.

4 Data can be entered into the Journal by either typing the titles and values 
directly or by using the right-click menu. Place the cursors to take 
measurements; then, select Add Title to Journal or Add Data to Journal 
from the right click menu to add the measurements to the Journal.

5 Divide the maximum clench force by 2. Enter this value in the Journal as 
the half-maximum clench force. 
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 Figure 3-6: The EMG (upper), EMG absolute integral (middle), and clench force (lower) 
during a prolonged muscle contraction as displayed in the Analysis window. The cursors are 
placed to measure the time needed to lose 50% of his maximum clench strength.

6 Determine the time it takes the subject’s forearm to fatigue to half its 
strength. 

• Put one cursor on the peak of the muscle contraction.  

• Move the other cursor to the right of the peak until the value for V2-V1 in 
the table at the top of the Analysis window is equal to the half-maximum 
clench force.  

• The value for T2-T1 when the cursors are in these two positions is the time 
it takes the subject’s forearm muscles to fatigue to half of their strength. Enter 
this value in the Journal as the time to the half-maximum clench force.

Exercise 3: 
EMG Intensity 
and Force in the 
Non-Dominant 
Arm

Aim: To determine the relationship between the intensity of EMG 
activity and the force of a muscle contraction in the subject’s non 
dominant forearm.

Procedure Follow the same directions used in Exercise 1 to record data from 
the subject’s non-dominant forearm.
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Data Analysis Analyze the data from the subject’s non-dominant forearm as it was 
done in Exercise 1. Use the information from Exercises 1 and 3 to 
answer the following questions.

Questions 1 Is one of the subject’s forearms stronger than the other? Use the 
maximum grip strength from each arm to determine this answer. Calculate 
the percent difference in maximum grip strength from each arm.

2 Does the stronger forearm have a higher ratio of average maximum grip 
strength to area of the EMG absolute integral than the weaker forearm? 
Use the slopes of the force-EMG activity graphs for each forearm to 
determine this answer. Calculate the percent difference in the slope of the 
force-EMG activity graph from each arm.

Exercise 4: 
EMG Intensity 
and Fatigue in 
Non-Dominant 
Arm

Aim: To observe the relationship between the length and strength of 
a muscle contraction and EMG activity in the non-dominant forearm.

Procedure Follow the same directions used in Exercise 2 to record fatigue 
data from the subject’s non-dominant forearm.

Data Analysis Analyze the fatigue data from the subject’s non-dominant forearm 
as it was done in Exercise 2. Use the information from Exercises 2 
and 4 to answer the following questions.

Questions 1 Is there a difference in the maximum forces generated by the dominant 
and the non dominant forearms? Calculate the percent difference 
between the forces.

2 Is there a difference between the circumference of the dominant and non-
dominant forearms? Calculate the percent difference between the circum-
ferences.

3 Is there a relationship between the circumference of the forearm and the 
maximum force developed?  If there is, what is it?

4 If there is a difference in the circumference of the forearms is it caused by 
a difference in the number of muscle fibers in the forearm or the diameter 
of each muscle fiber in the forearm? Explain.

5 How does the time to fatigue to half-strength in the dominant forearm 
compare to the same parameter for the non-dominant forearm?
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